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Overview
Welcome to Watermark Discovery ¾ a powerful new tool for managing documents. Watermark Discovery 
was designed to tackle the most serious problem facing most offices today ¾ the processing of paper. 
Watermark Discovery works by scanning paper documents and storing an image or photographic 
representation of the pages inside your computer. You will be able to use these images to automate many
of the time consuming tasks that waste time in the office today, such as:

Filing and retrieving letters, faxes, contracts, product specifications, etc.

Copying documents and sending them to your colleagues

Sharing documents to collect feedback in the form of comments

Processing forms that have to go through several stages for approval

Automating the handling of orders, invoices, delivery notes, etc.

What's more, Watermark Discovery doesn't require you to learn complex new techniques since it works 
with all your favorite Windows software. This powerful capability is accomplished by embedding Image 
Objects™ in other Windows applications. Watermark Discovery's Image Objects™ exploit a new feature 
of Windows that is called Object Linking and Embedding, or OLE for short. In particular, Watermark 
Discovery was designed to be used in conjunction with Windows E-Mail packages, Databases, 
Workgroup,    and Workflow software to create sophisticated applications that are tailored to your own 
personal and company needs.



Conventions
To help you locate and interpret information easily, this help system uses the following conventions:

Bold type is used to represent information that you must type exactly as it appears. For example, if asked
to type cd\Windows,    you would type the characters    exactly as they are printed.

Italic  type is used as a placeholders for information you must provide. For example, if you are asked to 
type Description, you would type a description of your document instead of the word shown in italic type.   
Italic type also signals a new term. An explanation immediately follows the italicized term.

CAPITALS are used for directory names, filenames, and acronyms.

Throughout this help system, menu choices appear as the name of the menu, a comma, and then the 
name of the menu choice.      For illustration, the choice Open on the File menu appears in this book as 
File, Open.    Menu choices that contain sub-menus or dialog boxes of their own are followed by ellipsis 
(...).    For example, if you selected Scan, Select Scanner..., Watermark Discovery would display the 
Select Scanner dialog box.

To use your mouse, click on the menu that you want and then click on the menu item.    To select File, 
Open, for example, you would click on File and then on Open.



Watermark Discovery's Unique Image Enabling 
Approach
Most imaging products use their own database front-ends, E-Mail systems, and workflow software to 
provide the functions that users require.    This type of imaging is called 'Image Centric.' Such products 
can only work alongside today's standard application packages. Watermark Discovery, however, is 
designed to work with existing standard Windows software. This concept is known as Image Enabling . 
While this idea has been attempted before, it has never been seamless for the user to implement. But by 
using Image Objects™ and the OLE mechanism of Windows, Watermark Discovery now offers a truly 
seamless architecture.

Image Objects™ allow you to store scanned documents and faxes into your preferred Windows database,
whether it is Paradox for Windows, dBASE, FoxPro, Microsoft Access, Approach, or whatever. Many such
databases are currently only able to store information that is in alphanumeric form, but Watermark 
Discovery allows you to add images to the database. To understand the power of this, imagine taking an 
existing customer database and being able to store all the correspondence, faxes, meeting notes, orders, 
etc. that relate to that customer in the same database.



Basic Concepts
This section discusses Image Objects™, Object Linking and Embedding (OLE), and the way in which 
Watermark Discovery stores its images. This is a very important section; we recommend that you take 
time to read it in order to understand how you can make the best use of Watermark Discovery.

Related Topics:
Image Object™
How Image Objects Work
Object Linking and Embedding (OLE)
OLE Containers and Objects
Compression and Optical Storage
Sending Images to Remote Locations
Faxing Images to Remote Locations



Image Object™
An Image Object™ is the raster (bitmapped) image of a Watermark Discovery image file that is 
embedded in another application file and linked back to the original Watermark Discovery file. You will find
more information about this and OLE in "Using Watermark Discovery with OLE."



How Image Objects Work
Watermark Discovery uses the Object Linking and Embedding (OLE) feature of Windows 3.1+ to embed 
Image Objects™ in other applications. 



Object Linking and Embedding (OLE)
OLE was first introduced by Microsoft in Windows 3.1, to allow users to share data between application 
more easily. When an OLE object is embedded into a document, it can be edited simply by double-
clicking the object. Windows then finds and loads the originating application.

Use of OLE is a significant advance over the traditional cutting and pasting that was available in Windows
3.0 and earlier versions. (When an item is pasted in without OLE, it retains no links to the application that 
created it, and cannot easily be edited.)



OLE Containers and Objects
An OLE container is any application that allows objects from other applications to be embedded. 
Documents that contain objects from other applications are known as container documents or destination 
documents. OLE containers were    historically known as OLE clients.

An OLE object is any application that creates objects that may be inserted into other applications. The 
OLE object is often referred to as the source document in this manual. OLE objects were historically 
known as OLE servers.

Some applications are both containers and objects. Watermark Discovery acts as an object when Image 
Objects™ are embedded in other applications. But Watermark is also an OLE container, allowing sound 
and other objects to be embedded in its own image documents as a form of comment.

Watermark Discovery Image Objects™ may be embedded in any Windows program that is capable of 
being an OLE container.

Examples of application packages that are OLE containers include:

Microsoft's Excel, Word for Windows, Access, FoxPro for Windows, Mail, PowerPoint, Visual 
Basic, etc.

Borland's Paradox for Windows, ObjectVision, QuattroPro for Windows, dBASE for Windows 
(when it is released)

BeyondMail for Windows

Lotus' cc:Mail for Windows 2.0, Ami Professional 3.0, 1-2-3 for Windows 4.0, Notes 3.0, and 
Improv

WordPerfect for Windows and WordPerfect Office

The standard Cardfile, Write, and Paintbrush programs that are supplied as accessories with 
Microsoft Windows

PowerSoft's PowerBuilder.

It is expected that most existing Windows applications will be updated to include support for OLE objects.

Related Topics:
Embedding an Object
Copying Watermark Discovery Objects from One Application to Another



Embedding an Object
Objects can be embedded in two ways: via the Clipboard (using normal Copy and Paste commands) or 
via the new Insert Object command that is often provided on the Edit menu of OLE container applications.

You can use the Insert Object command while you are running the container application.    The Insert 
Object command has the advantage that it will find and activate Watermark Discovery (the object 
application) automatically. For example, if you were writing an E-Mail message and you wanted to 
incorporate a press cutting, you would choose Insert Object... from the Edit menu and click on the 
Watermark Discovery option (shown as Image Objects). This would start Watermark Discovery. Then    
you would scan the image and close Watermark Discovery. The Image Object™ would be placed in your 
E-Mail message.



Copying Watermark Discovery Objects from One Application to Another
Watermark Discovery makes it easy for you to copy embedded image documents from one application to 
another. This powerful feature can be used in many ways.

For example, you could receive an invoice from a supplier and forward that invoice to the accounts 
department by embedding it in an E-Mail message. When the accounts department receives the 
message, they could copy the image into the database they use to track incoming invoices.

In OLE Version 1.0, you use the Clipboard and the standard Copy and Paste commands. 



Compression and Optical Storage
Typically, you will input images into the computer by scanning, but they may also come in the form of 
faxes received via a fax card installed in your computer. 

During input, the images are compressed to save disk space using the CCITT FAX Group IV compression
standard. An uncompressed scanned A4 or letter sized image would take between 400KB and 1MB, 
which would rapidly fill even a very large disk. Compression reduces the size to between 20KB and 50KB 
for each typical page.

Even compressed images will soon fill the average hard disk. Because of this, most imaging systems use 
optical storage systems. An optical disk offers a very large storage capacity on disks that are similar to 
today's audio Compact Disks. Optical disks can be used in jukeboxes to provide even greater storage 
capacity.

Although Watermark Discovery can be used to write to and read from optical disks that have been 
configured to look like a standard DOS drive, it is recommended that you upgrade to Watermark 
Professional when you reach this stage. Watermark Professional uses a sophisticated Image Server to 
manage optical storage and jukeboxes.



Sending Images to Remote Locations
If you send an E-Mail message that contains an Image Object™ to someone who is not on the same 
network as you, he or she will not be able to access the original image file. The Image Object™ will 
therefore not be visible.

You can overcome    this problem by embedding the whole Image File inside the E-Mail message. You 
should be careful when using this option, as the file size of an image is fairly large and will take some time
to transmit unless you have a fast modem or other high speed communications link. With a 9600 baud 
modem, sending an image will take about the same time as transmitting a fax.



Faxing Images to Remote Locations
Another way to send images to remote locations is to use a fax modem and appropriate Windows faxing 
software. In this case, you will simply choose the fax software as the printer driver and print the images 
from Watermark Discovery to this driver. During the print process, you will be prompted to enter the 
destination details and fax number.

Suitable fax packages include Winfax Pro, Ultra Fax, Eclipse Fax, and many others.



The Watermark Discovery Screen
Once Watermark Discovery loads, you can see the main Watermark Discovery screen. The buttons that 
are greyed out on the Toolbar are those functions that are not available until you scan in a new image or 
open an existing image file.

The screen layout conforms to the Windows' standard. The application name appears at the top center of 
the screen.    When you open a file, the name of this file appears there. The top left contains the 
application control menu button.    The maximize and minimize icons are in the top right corner. 

Watermark Discovery's main menu bar is below the top ribbon.    You can access these menus with your 
mouse or with a combination of keys. If you are not familiar with this process, please refer to your 
Microsoft Windows' manual. Also, refer to "Conventions" in this help system.

Below the main menu is the Toolbar, which contains buttons that provide fast access to the functions that 
are used regularly.    The Toolbar buttons are arranged in groups according to the functions that they 
perform. 

Additional buttons appear on the Secondary Toolbar located on the bottom left of the screen.    To the right
of these buttons is the horizontal scrollbar. The vertical scrollbar is located along the right side of the 
screen. 

The Ctrl key and the Shift key are important accelerator keys. The Ctrl key allows you to select an area of 
the image and to zoom into that area. The Shift key allows you to pan (to view a different part of the 
image). You will use these accelerator keys later in the tutorial.

Related Topics:
The Watermark Discovery Toolbar
Secondary Toolbar Buttons



The Watermark Discovery Toolbar

There are five groups of buttons on the Watermark Discovery Toolbar:

file manipulation buttons

copy and paste buttons

file properties and searching buttons

image manipulation buttons

annotation buttons.

The buttons on the Toolbar are in color when they are available and they are greyed out when they are 
not available.    Each button offers a quick way of performing one of the more important or frequently used
menu options. For example, the first button on the Toolbar allows you to open a file.    Using this button is 
the same as selecting File, Open.

Related Topics:
File Manipulation Buttons
Copy and Paste Buttons
Document    Properties and Searching Buttons
Image Manipulation Buttons
Annotation Buttons



File Manipulation Buttons
The file manipulation buttons are displayed and discussed below. Remember that when you use the 
keyboard equivalent, you simultaneously press the Alt key and underlined letter in the menu name.    Then
you press the underlined letter in the menu choice.

Use the Open file button to open an existing file and display it.

Use the Open fax button to import a fax file and display it. 

Use the Close file button to close the file currently displayed in the screen work area.

Use the Scan document button to scan a document.

Use the Print document button to print a page or whole document in accordance with your printer setup.



Copy and Paste Buttons
The copy and paste buttons are displayed and discussed below.

Use the Copy button to copy the current image file to the Clipboard as an Image Object ready for pasting 
into other Windows applications. (In Thumbnail View, the Copy button copies the current page to the 
Clipboard.)

Use the Paste button to    paste items that are on the Clipboard to the screen.

Note that Watermark Discovery also accepts the shortcut keystrokes of CTRL+X, CTRL+C and CTRL+V 
for the standard Cut, Copy and Paste commands. Also, Watermark Discovery has an additional 'copy' 
command (Copy Picture) that copies the page or a selection to the Clipboard as a bitmap rather than a 
TIFF image. 



Document    Properties and Searching Buttons
The document properties and searching buttons are displayed and discussed below.

Use the Properties button to associate search properties with the current document file.

Use the Search button to search for a file based on the associated file properties.



Image Manipulation Buttons
The buttons that allow you to manipulate the file image shown in the screen work area are displayed and 
discussed below.

Use the Thumbnails button to turn a thumbnail view (a view that shows multiple pages) of your image on 
and off.

Use the View Width button to scale the image to fit the full width of the current window.

Use the View Length button to scale the image to fit the full height of the current window.

Use the Magnifier button to put an image magnifier on the screen that allows you to select an area and 
zoom into that area.

Use the Rotate button to rotate the image 90° clockwise.



Annotation Buttons
The annotation buttons that allow you to annotate your image are displayed and discussed below.

Use the Text button to add typed comments to the image via the keyboard.

Use the Redliner button to add freehand sketches or writing to the image.

Use the OLE button to insert an OLE Embedded object into the current image.

Use the Sound button to embed recorded sound/voice comments.

Use the Highlighter button to highlight lines or blocks on the screen, similar to the effect of using a 
highlighter pen on paper.

Use the Arrow button to draw arrows on the screen to relate annotations to particular parts of the 
document.

Use the Eraser button to erase annotations from the screen image.

In addition to the main Toolbar, there is a Secondary Toolbar located at the bottom left of the screen.    
Above the Secondary Toolbar is a help line that provides information about the currently selected option. 
This line displays information only when you select a menu option or button.    



Secondary Toolbar Buttons
The Secondary Toolbar is located at the bottom left corner of the screen.    It contains the Zoom In and 
Zoom Out Buttons and a page indicator.

Use the Zoom In button to enlarge the image.

Use the Zoom Out    button to reduce the image.

Use the First Page button to display the first page of a multi-page document.

Use the Previous button to display the previous page of a multi-page document.

This area indicates the current page of the document (e.g., 1 of 1, 2 of 3, etc.) and allows you to go to a 
specific page in your document. To go to a specific page, click the mouse on the current page number, 
enter a value, and press the Enter key. 

Use the Next Page button to display the next page in a multi-page document.

Use the Last Page button to display the last page of a multi-page document.



Improving Performance
You can save a considerable amount of time by loading and then minimizing one copy of Watermark 
Discovery before you start to embed Image Objects™ in other applications. When you double-click on an 
Image Object™ in another application, much of the delay in opening the original Watermark Discovery file
is caused by loading Watermark into memory. If you have already loaded one copy of    Watermark 
Discovery, the operation is much faster. Even when you close the Watermark Discovery window that 
contains the embedded object file, the minimized copy remains in memory. This way, you can perform 
multiple embedding operations with different applications without wasting time by loading Watermark 
Discovery each time an Image Object™ is called from a different application.

Note that running multiple copies of Watermark does not use additional memory because Windows is 
smart enough to only load the program once. 



Introduction
This chapter discusses the types of scanners and scanner drivers that you can use with Watermark. It 
then tells you how to use Watermark Discovery with your scanner to produce TIFF file images. 



Scanners and Scanner Drivers 
You can use most scanners with Watermark as long as the scanner has a scanner driver that is supported
by Watermark. Watermark supports the following: 

ISIS drivers and ISIS-compatible scanners. ISIS, produced by Pixel Translations, provides direct drivers
for a wide variety of scanners. Because ISIS drivers are significantly superior to the TWAIN drivers that 
Hewlett Packard ships, Watermark has decided to bundle the ISIS drivers for the Hewlett Packard 
scanners. ISIS drivers can remember the scanner settings that you enter from one scan to the next. With 
most TWAIN drivers will have to enter the scanner settings every time you scan an image.    ISIS drivers 
are usually more robust than TWAIN drivers. You will find that certain scanner vendors are shipping ISIS 
drivers with their scanners (e.g., Ricoh or Ficus). If an ISIS driver is available for your scanner, we 
generally recommend an ISIS driver over a TWAIN. There are ISIS drivers for the following scanners:

Abaton Transcribe 300

Abaton 300/S

Abaton 300 GS

Abaton 300/ Color

Agfa ARCUS

Apple One Scanner

AST TurboScan

Bell & Howell 3338 (Kofax)

Canon IX-12

Canon IX-12F

Canon IX-30

Chinon DS-3000

Complete PC Page Scanner

Complete PC Flatbed (HP)

Datacopy 730

Datacopy 730 GS

Datacopy 830

Datacopy 830 GS Plus

Datacopy Jetreader

Dest PC Scan+

Dest PC Scan 100

Dest 2000

Dest 3000

Epson ES-300C / GT-6000

Epson ES-600C / GT-6500

Epson ES-800C / GT-8000

Epson GT-4000



Fujitsu Scan Partner 10

Fujitsu 3093E (w/Kofax)

Fujitsu 3096E+    (w/Kofax)

Fujitsu 3096G (w/Adaptec)

Fujitsu 3097E+    (w/Kofax)

Fujitsu 3097G (w/Adaptec)

Howtek Personal Color Scanner

IBM 3119 (MCA) only

Microtek MS-300A

Microtek MS-300C

Microtek MSF-300A

Microtek MSF-300C

Microtek MSF-300G

Microtek MSF-300Q

Microtek MSF-300Z

Microtek MS-400G

Microtek MS-II

Microtek SM 600G(S)

Microtek SM 600Z(S)

Microtek ScanMaker II

Panasonic FX-RS307

Panasonic FX-RS505

Panasonic FX-RS506

Pentax (HP)

Princeton Graphics LS300

Ricoh IS 50

Ricoh IS 60

Ricoh IS 410

Ricoh IS 510/520

Sharp IX-320

Sharp IX-610

Tamarac TS-6000C

Tamarac TS-8000C

UMAX UG-630

UMAX UC-630

UMAX UC-840

UMAX OA-1



UMAX 1200-C

Xerox/Pixelcraft 7650

You can order an ISIS driver from Watermark Software Inc. Our    phone number is (617) 229-2600 Our 
fax number is (617) 229-2989.

ISIS scanner drivers are generally a single file with a .PXW extension. This file must be placed in your \
WINDOWS\SYSTEM\ directory to work. Once the scanner driver has been installed, it will automatically 
appear in Watermark's Select Scanner dialog box.

TWAIN drivers and TWAIN-compatible scanners. TWAIN is an industry standard scanner driver 
specification that is supported by the Hewlett Packard Scanjet range, the Logitech hand scanner range, 
and many others.    TWAIN drivers were designed to handle subsections of a page for desktop publishing 
applications and cannot handle a full-page scan as well as ISIS drivers.

Bell+Howell makes a variety of high-speed scanners including those that scan single- and 
double-sided images and handle paper up to 11"x17".    Models include the 3338 and the 6338.

Fujitsu produces a range of scanners that you can use with Watermark. These include the 
M3096E, which handles paper up to 11"x17"; the M3097E, which can scan 37 pages per minute 
and can handle paper up to 11"x17"; and the M3093E, which can scan 25 pages per minute and 
can handle paper up to 11"x17".; and the TDC2610, which can scan 48 pages per minute and can
handle double-sided paper.

To install the TWAIN driver, follow the instructions that came with your scanner. 

Xionics image accelerator cards and Xionics-compatible scanners. Xionics makes image accelerator
cards for high-speed scanning. They support the following:

Bell+Howell, which makes a    variety of high-speed scanners including those that scan single- 
and double-sided images and handle paper up to 11"x17".    Models include the 3338 and the 
6338.

Fujitsu, which produces a range of scanners that you can use with Watermark. These include the 
M3096E, which handles paper up to 11"x17"; the M3097E, which can scan 37 pages per minute 
and can handle paper up to 11"x17"; and the M3093E, which can scan 25 pages per minute and 
can handle paper up to 11"x17".

The TDC 2610 model scanner, which can scan 48 pages per minute and can handle double-sided
paper. 

Ricoh scanners.

To install the Xionics driver, follow the instructions that came with your Xionics board.

Related Topics:
Preparing your Scanner
Scanning
The Scan Options



Preparing your Scanner
Scanning hard copy documents with Watermark Discovery is simple provided that everything is set up 
correctly. 

Make sure your scanner is correctly installed. Refer to your scanner supplier's documentation for the 
instructions on installing the scanner.    Pay    particular attention to any switches on the interface card. 

Make sure that you have installed the correct Watermark Discovery scan driver for your scanner. Several 
scan drivers are supplied on the Watermark Discovery installation disks, which are installed automatically 
during setup unless you removed the check from the scan driver checkbox. If there isn't one suitable for 
your scanner, ask your Watermark Discovery supplier to see if any new drivers are available. 



Scanning
In most cases, you will be able to use the Scan menu to operate the scanner from within Watermark 
Discovery.      Operating the scanner from within Watermark Discovery is possible only when the scanner 
software permits it.    If your own scanner does not permit this, then you will need to run the scanner 
software separately. Set it up to produce TIFF files, and save them into your Watermark Discovery image 
directory.



The Scan Options
Once your scanner has been correctly set up, scanning a document is as simple as placing the source 
document on the scanner's copyboard glass and clicking the Watermark Discovery scanner button on the 
Toolbar. 

But before you reach this stage, you must first establish the correct configuration between Watermark 
Discovery and your scanner. To do this, you use the Scan menu options:

Select Scanner

Scan Setup

Scan

Related Topics:
Scan, Select Scanner
Setting up your Scanner (non-TWAIN Scanner Drivers)
Setting up your Twain Scanner



Scan, Select Scanner
The Scan, Select Scanner option allows you to select the scanner that you want to use.    If you are using 
Watermark Discovery as a stand-alone system, then you will probably have only one available scanner. 
However, if you are using Watermark Discovery on a network, then it is possible that there will be more 
than one scanner installed. Either way, you must use this option to select the scanner you are going to 
use.

When you select this option, the Select Scanner dialog box appears, listing all available scanners. Select 
the scanner you plan to use. If this is the only scanner you will be using, click the Set as Default Scanner 
button at the bottom of the dialog box. The selected scanner name will appear in the Default Scanner box 
at the top of the dialog box. Once you establish a scanner as the default scanner, you do not have to use 
the Scan, Select Scanner option.    Watermark Discovery will automatically use the default scanner. When
you have chosen the scanner you will be using, click the Select button.



Setting up your Scanner (non-TWAIN Scanner Drivers) 
If your scanner has a driver that is not a TWAIN, use the Scan, Scan Setup... command initially to set up 
your scanner or to change your scanner settings. Scan, Scan Setup... displays the setup panel. Note that 
the setup panel varies depending on the scanner and the scanner driver that you use.

If you select Scan, Scan Setup...    for a TWAIN interface, you get the error message "You have selected a
TWAIN scanner. TWAIN scanners can only be set up just prior to scanning." 

Use the control panel to set up your scanner. Refer to your scanner and scanner driver documentation for
detailed information on the operation and effect of the different options.

Note that if you use the Scan, Scan Setup command when you have a TWAIN driver, the error message 
"You have selected a TWAIN scanner. TWAIN scanners can only be set up just prior to scanning."



Setting up your Twain Scanner      
If you are using a TWAIN scanner driver, you do not use the Scan, Scan Setup command to set up your 
scanner. Instead, the scan setup panel displays automatically whenever you select Scan, Scan to scan in 
an image. With TWAIN you have to set up the scanner before every scan. If you use other drivers, you 
only have to set up the scanner when you want to change your scanner's settings.        

To scan in an image if you are using a Twain driver:

1. Use Scan, Select Scanner... to select your scanner.

2. Place the image on your scanner      . 

3. Select Scan, Scan or use the Scan button on the Toolbar.

The TWAIN driver displays the TWAIN setup panel. Note that the setup panel varies depending 
on the scanner that you use. 

4. Use the control panel to set up your scanner. Refer to your scanner documentation for detailed 
information on the operation and effect of the different options. Set the resolution to a least 200 
dpi. If you plan to use OCR, we recommend that you set the resolution to 300 dpi. Also verify that 
the document size has been set correctly. 



Introduction
This chapter looks at the different ways in which you can manipulate an image document. Image 
manipulation falls into two categories: movement around the screen image (for single page documents 
and the current page of multi-page documents) and page editing (multi-page documents).

It is important to be able to see different parts of a page in different degrees of detail. Sometimes you 
need to look at the whole page, sometimes you need to examine carefully a particular part of the page. 
How this is achieved can be critical. Systems with limited image manipulation facilities can hamper your 
work. Moving about the image can be time-consuming and annoying. But Watermark Discovery is rich in 
manipulation features. They allow you to move about the image quickly and accurately, and make 
Watermark Discovery fast and easy to use. The section "Image Handling," which follows, shows you how 
to move around on a page.

Watermark Discovery's document handling facilities allow you to see all of the pages in a document, 
move from page to page,    remove pages, reorder pages, and to add new pages or whole documents. 
The section "Page Editing," which follows, shows you how to handle the pages in a document. 



Image Handling
The image handling tools are found in the View and Tools menus.    Chapter 11, Reference, tells you 
about all of the options on these menus.    You can also access Width of Page, Length of Page, Magnifier, 
and Rotate from the Toolbar.    The Zoom In and Zoom Out buttons are located on the Secondary Toolbar.

Image handling facilities allow you to see different parts of the document in different degrees of detail. 
They let you zoom in for greater detail, zoom out for an overview, and move around the page image.

Related Topics:
View Width/Length of Page
Zooming
Panning
Using the Magnifier
Zooming with the Secondary Toolbar
Rotating your Image



View Width/Length of Page
The Width of Page and Length of Page options are two of the most important image handling commands. 
You can access them from the Toolbar or from the View menu.

Length of Page scales the image so that you can see its full height within the current window. To view the 
entire length of an image, select View, Length of Page or use the Length of Page button on the Toolbar. 

Most documents are used in portrait mode; that is, they are taller than they are wide. The Length of Page 
tool is the quickest and easiest way to see the whole page.

The Width of Page command scales the image so that it fills the full width of the window. To use the full 
width of the screen, select View, Width of Page or use the Width of Page button on the Toolbar.



Zooming
To see part of the page in greater detail, use the Zoom tool.    To use Zoom, press and hold the Ctrl key. A 
magnifying glass cursor displays.    Place the cursor at the top left of the area that you want to see, hold 
the left mouse button and drag the cursor to the bottom left of the area.    Then release the key and the 
mouse button. Watermark displays the selected area in greater detail. Repeat the process to zoom in 
further. 

You can do the same thing by selecting Tools, Zoom instead of using the Ctrl key.    Note that when you 
select Tools, Zoom you have to select Tools, Zoom or another tool to get out of zoom mode. 



Panning
When you zoom into a portion of the page image to examine the contents in detail and you want to see 
some of the surrounding image that is just off the screen, use the Pan Tool.    To use Pan, press and hold 
the Shift key. A four arrow cursor displays.    Now press and hold the left mouse button and drag the 
mouse as follows. To see what is off the left of the screen, you drag the mouse to the right; to see what is 
off the right of the screen you drag the mouse to the left; and to see what is off the top of the screen, you 
drag the mouse downwards.

The screen image moves as you move the mouse and the cursor. When you can see the area you wish to
examine, simply release the mouse button and the Shift key. 

You can do the same thing by selecting Tools, Pan instead of using the Shift key.    Note that when you 
select Tools, Pan you have to select Tools, Pan or another tool to get out of Pan Mode. 



Using the Magnifier
The Magnifier option, which you can access by selecting View, Magnifier through the View menu or 
through the Magnifier button on the Toolbar, allows you to zoom and pan in a single process. When you 
select View, Magnifier, the Magnifier window appears on the screen. You can move and size this window 
independently. To demonstrate the effect, open a portrait image file and select View, Length of Page. This 
shows you the whole image on the left side of the screen. Now select the View, Magnifier.

The Magnifier window appears on the screen. It is positioned and sized the way it was the last time that 
you used it during this session.    The first time you use it, it appears in the top left corner of the window. 

Move and size the window so that it fills the right portion of the screen that is currently blank. You will find 
that a magnified view of the image appears in the Magnifier window. The enlarged view reflects the 
original position of the Magnifier glass over the image. When the cursor is over the image and outside the 
Magnifier window, it changes to a magnifying glass.

To see an enlarged view of a different part of the document, place the cursor outside the Magnifier 
window on the part of the image that you want to magnify and click the left mouse button. A box, which is 
a scaled down image of the size and shape of the Magnifier window, appears.    A magnified view of the 
boxed area that you select displays in the Magnifier window.    To magnify    another area of the image, 
move the cursor to that area and click.

To zoom in or zoom out of the image in the Magnification window by fixed degrees, use the Zoom In and 
Zoom Out button located in the left corner of the Magnifier window.



Zooming with the Secondary Toolbar
The Zoom In and Zoom Out buttons on the Secondary Toolbar allow you to zoom in or out of the image in
fixed degrees. As you zoom in, the area of the image that is magnified is that area currently displayed in 
the top left of the screen.



Rotating your Image
Occasionally, you will have images in portrait mode that should be viewed as landscape images. This 
could be caused by the way faxes have been sent to you or by limitations in your scanner. Watermark 
Discovery has a Rotate command that allows you to rotate the image by 90° increments in a clockwise 
direction to the correct viewing angle. You can rotate your image by selecting View, Rotate or by using the
Rotate button on the Toolbar. Because rotating an image takes time, Watermark displays the hourglass 
cursor during the process.

When you select Rotate from the View menu, Watermark Discovery displays a sub-menu.    You can 
select the amount of rotation from this sub-menu. The sub-menu provides the following choices:

Clockwise 90 degrees

Flip 180 degrees

Counter-clockwise 90 degrees

When you select the Rotate button on the Toolbar, the image will rotate by 90° in a clockwise direction.



Page Editing
Use the page editing tools to navigate and manipulate multi-page documents.    You can insert a blank 
page in front of the current page on the screen by using View,    Insert Blank Page.    Edit, Insert Files 
inserts a complete TIFF image file, whether single page or multi-page, into the current document.    You 
can view a thumbnail view of the document by using    View, Thumbnail or the Thumbnails button on the 
Toolbar. You can page through a document by using the buttons on the Secondary Toolbar.

Related Topics:
Thumbnail View



Thumbnail View
The Thumbnails Tool is one of the most useful editing tools. You can access it through the View menu 
(View, Thumbnails) or through the Thumbnails button on the Toolbar.    Use Thumbnails Tool to place 
small images (thumbnails) of all the different pages of a complete multi-page document on the screen 
together. In a particularly large document, you can scroll down with the vertical scroll bar to see all of the 
pages. Thumbnails Mode has two main functions: it allows you to navigate through a document and it 
allows you to change the order of the pages.

Navigation.    Thumbnails allows you to move rapidly from one page to another without having to use the 
page-forward or page-backwards buttons or menu commands. To use Thumbnail Tool, click on the 
Thumbnails button or use View, Thumbnails. Small images (thumbnails) of each page are displayed side 
by side on the screen. This allows you to see the whole document at once. 

The images are too small to be of use in themselves, but they are large enough for you to recognize 
which page you wish to examine more closely. To display a full page view on your screen and close 
Thumbnails Mode, move the cursor to that page and double-click on the image. This closes Thumbnails 
Mode and displays the selected page in full view on the screen. 

This method of document navigation allows you to move straight to any page anywhere in the document 
using the minimum number of keystrokes and time.

Another way to move around the document is to use the four buttons on the Secondary Toolbar 
(equivalent to View, First Page, View, Previous Page, View, Next Page and View, Last Page). On any 
document that is no more than four pages long, this method is likely to be faster than using the 
Thumbnails tool for navigation.



Introduction to Annotation Tools
This chapter looks at Watermark Discovery's annotation tools, which let you mark up documents in 
Watermark in a similar way to how you would mark up paper documents. The annotation tools are:

Text, which allows you to add typed text to your document

Redliner, which allows you to add freehand notes to your document

OLE, which allows you to place an OLE object on your document as an annotation 

Sound, which allows you to add recorded comments to your document

Highlighter, which allows you to accent important information in the document

Arrow, which allows you to create arrows on your document to link annotations to parts of the 
image or to point out important information

Eraser, which allows you to delete your annotations

Hide Comments, which allows you to mask the annotations on the document

Show Comments, which allows you to show the annotations on the document

Once you have made annotations on your document, you can then embed the document image into an E-
Mail document and send it to your co-workers. Each recipient can comment on the same document and 
pass it on. The comments are stored with the file, but do not change the original document. This process 
eliminates many of the problems that occur when you deal with paper. With paper, you need to make 
copies of the document, distribute the copies to your co-workers, have the recipients comment on the 
different copies, collect the commented copies, and then collate the different comments. If you circulate 
one copy to all of the recipients, you must track the document and deal with the internal mail system.

The main annotation tools can be found in the Tools menu and on the Toolbar. They are    Text, Redliner, 
Sound, Highlighter, Arrow, and Eraser. They are best viewed as modes that you can toggle on and off. 
Each of these modes except Eraser has a sub-menu that can be displayed by clicking the right mouse 
button. For details on the sub-menus, refer to Menus and Menu Choices.

Note that there is also an OLE object command that you can select from the Toolbar or from the Tools 
menu. Object Linking and Embedding and OLE 'comments' are so integral to maximizing the value of 
Watermark that the subject is treated separately in "Using Watermark Discovery with OLE."



Text Annotations 
Text annotations (Tools, Text or Text button) are probably the most important method of annotation 
because they are the easiest to read. However, there are certain fundamentals that you should 
understand in order to use them. 

There are several ways that you can avoid letting the comment obscure the text or illustration that it 
annotates. First, you can type the annotation on a blank or unimportant part of the page and use an arrow
to indicate the point that it illustrates.

Note that while you can set the text color with the Text tool    sub-menu (the menu that displays when you 
hold the left mouse button) , you cannot set the background color. This must be done with the Edit, 
Preferences Comment command. Note also that this command sets the preferences for subsequent 
annotations; it cannot be used to change existing annotations. To change the appearance of existing 
annotations, use the Text tool sub-menu.

A second method that can be used to avoid obscuring the image is to place the comment slightly off of the
edge of the image. As we have already seen, most images will only occupy a small section of the screen 
while in Length of Page view. The whole part of the greyed portion of the screen could be used for Text 
annotations. In such instances, it would be useful to use a dark foreground color for the text, but to switch 
off background transparency and use a light background color. This will make the text easier to read 
against the grey part of the screen. Such annotations will still be saved with the file even though they are 
not actually on the image itself.



Redliner Annotations
The Redliner, which you can access through Tools, Redliner or the Redliner button on the Toolbar allows 
you to make freehand notes on the image



Sound Annotations
Watermark Discovery can embed sound recordings into its image files if you have suitable hardware 
installed. The Sound Comment tool is an excellent way of adding voice annotations to the document. For 
example, you could embed a few voice comments to co-workers who need to look at a draft of a contract.

To add sound annotations to your document, click on the Sound button on the Toolbar. Then move the 
cursor to the area on the image where you want the sound icon to appear and click. The recorder dialog 
box appears.    This box varies depending upon the sound card software that you are using. Select the 
record button and record your message. 

When you complete your recording, use the stop button on your recorder dialog box and close your 
recording application. Next, a message appears that asks you whether you want to add the recording to 
your document.    If you select Yes, the microphone icon appears on the image document.    Don't forget to
exit from the Sound tool by clicking the Sound button. You can now save your image file and embed it into
an E-Mail document for circulation to your co-workers.

When you receive a document with a microphone icon, you can play the sound by double-clicking on the 
icon. If you use the Sound sub-menu (press the right mouse button to use the sub-menu), you can even 
edit the recording.



Highlighter Annotations
The Highlighter, which you can access through Tools, Highlighter or the Highlighter button on the Toolbar, 
highlights portions of the document to draw the reader's attention to part of the image. It is similar in use 
to the highlight pen used on paper documents. It places a colored rectangle over a defined part of the 
document.

You can customize the color of Highlighter, but note that the darker the color, the less visible the image 
beneath it. If you choose a dark color, you are more likely to hide than to highlight the image. The default 
yellow is recommended.



Arrow Annotations
The Arrow tool, which you can access through Tools, Arrow or the Arrow button on the Toolbar, draws the 
reader's attention to a precise point on the document image. As with the Text and Redliner comments, you
should experiment with the different Arrow Mode properties to find the best setting for each different 
requirement.



Eraser Tool
The Eraser allows you to erase existing comments. To erase an existing comment, select Tools, Eraser or
use the Eraser button.    Watermark Discovery displays a pencil-with-eraser cursor. Move the eraser end 
of the cursor to the comment that you want to delete and click the left mouse button. Text, Highlighter, and
Arrow comments disappear. To remove Redliner comments, trace the parts of the comments that you 
want to remove.    As you hold down the button, the traced area changes color. When you release the 
mouse button, the comment disappears. 

If you have a large number of comments to erase, use the comment sub-menu's Clear command rather 
than the Eraser Mode. The quickest way of doing this would be to click the comment concerned with the 
Standard Mode's normal pointer cursor. This will select the comment, and it will briefly change color. Then
press the right-hand mouse button. This displays the comment's sub-menu. Choose Clear and the whole 
comment disappears. But note: all of the comments produced on a single page during one session of the
particular comment Mode will be removed. Watch carefully which comments change color when you click 
the mouse button. They will all be removed. This does not apply to comments written on a different page 
during the same session. Be very careful of using this fast Clear method to remove a co-worker's 
comments ¾ you may not know how many other, and perhaps important, comments were made in the 
same session.



Hide/Show
The Hide and Show options allow you to toggle the display of comments off and on. View, Hide allows 
you to hide the comments on an image.    Because Hide masks the comments on a document, it is useful 
when the comments obscure the image. If existing comments are hidden, you can display them again 
them by using View, Show.



Introduction to Windows OLE
Object Linking and Embedding (OLE) is a feature of Windows. It was introduced by Microsoft in version 
3.1. It is not available to all software running under Windows ¾ only that software that specifically 
supports OLE. It is designed to allow you to include the output of one application in the output of another 
application.    For example, you could include a spreadsheet graph produced by one application in a word 
processing report produced in another. In this example, the graphing application is called the object or the
source application. The word processing package is called the container or the destination application.

OLE combines two technologies: object linking and object embedding. In this context, the object is the 
data from the source application that is included within the destination file. It could be a complete multi-
page file (another word processing document) or a single page item such as a graph or diagram from a 
spreadsheet or graphics package.

Related Topics:
Object Linking
Object Embedding
Watermark's Image Objects



Object Linking
A linked object maintains a link between the source and destination applications. If it is a Microsoft Excel 
graph included within a Microsoft Word document, then the graph will change to reflect the condition of 
the source file. If you edit the graph under Excel, then the graph in the Word document will also change. It
changes dynamically if both applications are running or at start-up if the destination application (Microsoft 
Word) is not running. If you double-click a linked object, Windows locates the source file and 
automatically loads it and its relevant application. You can change the graph and leave the source 
application without leaving the word processing document. When you close the source application, you 
are usually given the option of updating the graph in the container.



Object Embedding
An embedded object is stored in its entirety within the destination file, and allows you to edit the object 
from within that file. You do not need a separate file to hold the 'original' data ¾ indeed, there is no 
separate file. Thus, if you embed many objects into a single destination file, the size of that file will 
increase dramatically. If you have a graph within a word processing document, you can edit the graph 
without having to locate the original application and the original file. With an embedded object, you merely
double-click on the object and Windows loads the source application and the embedded object.



Watermark's Image Objects
Watermark only uses embedding. But, when you embed an Image Object™ from Watermark Discovery 
into another application, it is not a full copy of the file; it is just a pointer to the image file. This provides the
advantages of an embedded object without the overhead of increased container file size.



Using OLE
The precise method of using OLE will vary slightly between different packages, so it is best to study the 
relevant application user manuals. Where OLE is possible, there are generally two methods of using it, 
depending upon whether you are currently working in the source or destination application. You can copy 
to the clipboard or you can use the Insert Object command.

Related Topics:
Copying to the Clipboard
Using Insert Object...



Copying to the Clipboard
For example, if you are working in Watermark and you wish to embed your image into a Microsoft Word 
document, you can simply use Copy & Paste. Select the image you want and use the Toolbar button to 
copy it to the clipboard. Load Microsoft Word and open the destination document. Paste in the graphic 
from the clipboard to the place that you want it. 



Using Insert Object...
To include an OLE object from another application in the file that you are currently using, use the Insert 
Object command in the Edit menu. This command varies from application to application. For example, 
Microsoft Word has an Object command in the Insert menu and Paradox for Windows does not offer the 
command.

Once you use the Insert Object command, you will be presented with an Object selection box, which lists 
all the objects installed on your system that support OLE.

From this selection box, choose Image Objects. When you do this, Watermark will    load. You can now 
scan a document, open an existing document, or import a fax. 

When you close Watermark, you will be asked if you wish to update the destination file. If you respond 
"YES," the Image Object™ will be embedded into your original file. Whenever you want to view the Image
Object™, you simply double-click on the object.



Watermark Discovery and OLE
We have discussed Windows OLE in some detail because it is fundamental to the use of Watermark 
Discovery. Watermark Discovery can act as both an OLE object (server) and an OLE container (client). 

Watermark's main use of OLE is to embed images into other applications. For example, you could embed 
an image file in: 

an E-Mail package to allow you to distribute the image file to co-workers

a database package (for example, Paradox for Windows) to provide a sophisticated document 
storage and retrieval system, or to link database records with relevant documentation (personnel 
records linked to a photograph and/or original contract documentation, etc.)

any application that runs under Windows 3.1+ and supports OLE.

Related Topics:
OLE Comments
Copying an    Image Object from One Application to Another



OLE Comments
An OLE comment is an embedded object from another application. Despite Watermark Discovery's 
extensive annotation features, there may be times when you want to make comments that cannot be 
produced by Watermark Discovery alone (for example, if you wanted to include a graph to illustrate a 
point within a document or a spreadsheet to provide analysis for a financial document). (Note that you can
even embed an Image Object™ as a comment on an image.)

For an illustration of    how to embed an object from another application into Watermark, refer to 
"Embedding an Image Object™ into a Watermark Image" in Chapter 4 of the Watermark Discovery User 
Manual.



Copying an    Image Object from One Application to Another
One very useful feature of OLE and Watermark is the ability to copy an Image Object™ from one 
application to another application. This is done by using the standard Windows' Copy and Paste to 
clipboard commands. The example that follows illustrates this feature. 

A manager receives a mail message that includes an Image Object™. That Image Object™ is a resume 
that was scanned into Watermark and included in a Microsoft Mail message. When the manager reads 
the message, he decides that he wants to keep the resume and file it in his database cardfile.

The manager does the following to copy the resume to his resume database:

1. Selects the Image Object™ (the resume) by placing the cursor on it and clicking the left mouse 
button. 

2. Selects the standard Windows' function Edit, Copy.

3. Quits out of Microsoft Mail.

4. Loads his database, which is Microsoft Cardfile.

5. Puts Cardfile into Picture Mode (Edit, Picture).

6. Selects the standard Windows' function Edit, Paste.

The Paste Command places the Image Object™ (the resume) into the cardfile.



Overview
The most effective way to store images for later retrieval is to embed them in other Windows applications 
such as a database or personal information manager. However, Watermark provides another mechanism 
for managing the large number of TIFF image files that can be created.    These facilities are Document 
Properties and Searching. They are available through the File menu and on the Toolbar.

It is important to read this chapter and understand the relationship between Properties and Searching 
before you start entering new file properties. Well organized properties will lead to an efficient filing 
system. Badly organized properties will mean wasted effort and longer search times. It is a good idea to 
have an overall policy for Document Properties, perhaps under the control of the Systems Administrator 
or company librarian.

Properties are file-specific details that you can associate with individual files. To associate these details 
you use the Document Properties window, which you reach by using the Properties button or the File, 
Properties… command. Watermark assigns some of the properties but you provide the majority.

The File Search facility allows you to search your database of image files using    the Document 
Properties that you assigned when you created the document.    To search for a specific file, you specify 
the search criteria on the Search Document Properties window. You reach the Search Document 
Properties window by using the Search button or by selecting File, Search.... 

Related Topics:
How Document Properties and Searching Work



How Document Properties and Searching Work
Document properties are stored in each file. When a search request is made, Watermark Discovery 
searches first through the directory specified to store image files looking for each Watermark Discovery 
TIFF file. Each time it recognizes a file, it looks for the properties and matches them to the search criteria.

Watermark Discovery does not need to load the entire TIFF file in order to access the document 
properties. Because it just looks at the beginning of each TIFF file, the process is very fast.

If you fail to locate any document(s) matching your search criteria, you can specify alternative physical or 
logical disk drives to search.

In Watermark Professional Edition, document properties are stored in an SQL database. They provide 
high speed access and searching, even when dealing with millions of documents. If you upgrade to the 
Professional Edition, you will be able to import the document properties created with the Discovery 
Edition.    



Document Properties
Because of the way that properties are stored by Watermark Discovery, you must have a document open 
before you can use the Properties facility    to define the properties of a document.    To use Properties, 
open the file to which you want to assign properties. Then select File, Properties…    or use the Properties
button. Watermark Discovery displays the Document Properties window. 

There are four areas on the window in which you can enter new properties: Basic properties, Deletion 
Rule, Keywords, and User defined fields. A thumbnail of the first page of the current image file is 
displayed at the bottom left of the window.

Related Topics:
Basic Properties
Deletion Rule
Keywords
User Defined Fields



Basic Properties
The basic properties include:

Document name

Created by

Date created

Type

Description

Document name.    Use this field to enter an individual name for the document. It is a good idea to make 
the name describe the content of the file. You can use up to 32 characters including spaces.

Created by.    This field is automatically entered by Watermark Discovery. It is taken from the name you 
used to personalize your copy of the software during installation. You can, however, change the entry    or 
add additional names. You can use up to 24 characters including spaces.

Date created.    This field is automatically entered by Watermark Discovery. It is taken from the system 
date.    The format is taken from your Windows setup, so if you change the date entry, then the new date 
entry must conform to your Windows standard.

Type.    Document type allows you to group documents    by content. When you open the Document 
Properties window, a series of 'type' options is available. You can either click on one of these options or 
enter a new one. If you enter a new type of document, this new 'type' becomes available in the list of 
options for other files.

The user defined fields are directly associated with the document type. Therefore, if you choose a type of 
document that was already set up with user defined fields, these same field labels will automatically 
reappear. 

We suggest that you use group types such as:

Invoice
Contract
Purchase order
Correspondence
Expense forms

In this way, if you wish to look at a history of your invoices, you can simply use File, Search Type Invoice 
to locate all of your stored invoice image documents. However, it is important that you have a consistent 
company policy concerning type names. If you use Correspondence and one or more of your co-workers 
uses Letters, then you will not be able to locate all of the relevant files during a search operation.

Description.    Use this field to enter a more accurate description of the file contents. You can use up to 
40 characters including spaces.



Deletion Rule
The Deletion Rule allows you to specify when a document should be deleted. To use this facility, click the 
check box in the Deletion Rule area. Then select an expiration time of 3, 6, or 12 months from the drop 
down list or type an expiration time in the box provided. 

Watermark does not automatically delete documents. However, it does allow you to search for documents
that are due for deletion. You can then delete them from the system from within the Search Results dialog
box.    We highly recommend that you use this feature to avoid taking up unnecessary disk space.



Keywords
The Keywords area allows you to specify important words that describe your document.    These 
keywords will then be available to be used as search criteria to locate your document.

To enter keywords, type the keyword in the Keywords field and use the Add button.    Keywords can 
contain up to 24 characters including spaces.    To delete a keyword, select the keyword and use the 
Delete button.



User Defined Fields
User defined fields are special fields that you can associate with individual files. Each user defined field 
has two parts: the label and the data. To maximize the value of the user defined fields, you should specify 
both the label and the data when you use the File, Search… command. 

You enter new user defined fields by clicking on the Edit Fields button. This brings up the User Defined 
Fields box.

The User Defined Fields window allows you to enter up to 10 different labels of up to 16 characters each. 
When you click the OK button, the specified labels will appear in the Document Properties window. An 
empty box appears alongside each new label. Here you can directly enter the data you wish to associate 
with each label. The user defined fields are stored together with the type of document. If you select a 
document type that has been used before, the field names for that document type will automatically 
reappear.    

You can use up to 24 characters for each entry. When you have finished defining the Document 
Properties, click the OK button. This will close the Document Properties window and return you to the file 
image screen. The properties will be associated with that file. Remember, that you must save the file. 



File Search
The File Search facility allows you to find a document or set of documents based on the criteria that you 
specify. To search for a document, select File, Search... or use the Search button on the Toolbar. You 
don't need to have a file open. The command displays the Search Document Properties window, which is 
similar to the Document Properties window.

To use the Search Document Properties window, enter the search criteria that you know into the 
appropriate boxes. You may also enter the first few characters followed by an asterisk (*).

Watermark Discovery then searches through all the TIFF files that it recognizes looking for any files that 
match the specified search properties. If    it finds a file that meets the criteria, it lists those files in a 
Search Results window. If you recognize the file you are looking for, simply double-click on the filename.   
Watermark Discovery will display that file.

You can also highlight any file in the Search Results list by using    your mouse or by using the up and 
down arrow keys on the keyboard. Watermark displays the thumbnail, Document Description, and full 
path for the selected file.

If you get a message stating that no matching files have been found, there could be two reasons:

1. You have no files with the specified properties.

2. The file you are seeking is stored on a different disk or directory than the directory you specified 
for file storage during installation. Notice the list of available drives at the bottom right of the 
Search Results window. In the following example, all of our images are stored in directory C:\
IMAGES. However, the storage directory that we specified at installation was C:\WATERMRK\
IMAGES. Since Search examines only the specified directory, it has found nothing. If we now 
click on the C drive, Search will examine all of the directories and sub-directories on the C: drive, 
and will locate the image files. Similarly, if we don't know where the files are stored, we can just 
work through all of the available drives until the file(s) are located.



Tips on Using Properties & Search
1. When you define the Document Properties, don't skimp on the basic properties that you assign. 

These details are shown in the list of files found in the Search Results window. They will usually 
be enough for you to recognize the file you are seeking even in fairly lengthy lists.

2. If you do not enter any search criteria in the Search Document Properties window, Watermark 
Discovery locates all the files in the image storage directory. In some cases, it may be faster to 
scan the document name details shown in the Search Results window in order to locate a specific
file. Once you recognize the file you are looking for, you can open it by double-clicking on the 
details.

3. Try to search for files on as few properties as possible. The more complex the search criteria, the 
fewer files will be located ¾ but the greater the chance of entering an incorrect property 
specification and missing the file altogether.

Related Topics:
Another Approach
Deletion Assistance



Another Approach
If you intend to use Watermark Discovery as a large scale electronic document storage and retrieval 
system, we strongly suggest that you use an OLE supporting database application to manage the files. To
do this, you should define your database so that each record contains one OLE field in which Watermark 
Image Objects™ will be stored. The other fields in each record will be the criteria by which you wish to 
search the database and locate individual or groups of files.

When the database structure is complete, simply embed an Image Object™ of the file concerned into the 
database record, and enter all the details you wish to record against each file. This allows you to develop 
a storage and retrieval system tailored exactly to your own requirements.



Deletion Assistance
You may also use the Search facility to search for files that are due for deletion. Any files found may then 
be individually deleted. To accomplish this, use the Search button on the Toolbar or File, Search.... Check 
the box marked "Only Documents that are due for deletion." Then select the Search button.    Watermark 
presents you with the search results, as before, but this time there is a Delete button. To delete a listed 
file, select the file using your mouse or the up and down arrow keys.    Then use the Delete key.    This 
process deletes the image without displaying a warning message.



Benefits of Using Watermark Discovery on a Network
Watermark Discovery can be used on a network to allow documents to be shared by many individuals. 
This chapter discusses the issues that you should address to maximize the benefits of using Watermark 
Discovery on a network.

Watermark Discovery makes full use of the OLE feature of Windows introduced by Microsoft in Windows 
3.1. When you use Watermark as a stand-alone system, Watermark and OLE allow you to develop a very
efficient storage and retrieval system. For example, if you maintain a contacts database with an OLE-
supporting database application, you can link relevant documents to individual contacts. This allows you 
to check up on important details either before or during telephone conversations. To refer to an earlier 
correspondence during your conversation, you can call up the original document in a matter of seconds.

However, it is when Watermark is used on a company-wide network that the full value of Watermark 
Discovery can be realized. In the above situation, anybody on the network can access the associated 
correspondence immediately. When someone is not at work, co-workers can fill in.

E-Mail also allows you to send scanned documents and faxes to other people in a way that is much more 
effective than distributing paper photocopies.

In addition to E-Mail, there are many other applications that can benefit from integration with Watermark 
Discovery. For example, in workflow applications, electronic forms are moved automatically from one 
person to the next to complete a task. In many cases, the work must stop while each user locates and 
considers hard copy documents. If the relevant documents were available as embedded Watermark 
Discovery Image Objects™, then the recipients could access these documents immediately. Informed 
decisions could be made more quickly and effectively, and the process could be streamlined.



Watermark Discovery's Image Objects™
Embedding the entire image file into an E-Mail or workflow document could greatly increase the size of 
the container document. Transmitting the document from one workstation to another would then place a 
particularly heavy load on the network throughput. 

Watermark Discovery uses Image Objects™, which are pointers to a single copy of the image file that is 
stored stored on the network. This approach has two advantages:

1. Network traffic and the disk space used is minimized.

2. Annotations made by one user are immediately available to all other users.



Points to Consider
Users
Image Directory
Storage Medium
Scan Servers
Fax Servers
Wide Area Networks
Security
Points to Remember
Sending Images to Remote Mail Users



Users
One of the major uses of Watermark Discovery is to distribute image documents to different users on a 
network. Therefore, each user that you wish to include in such an operation must have a personal copy of
Watermark Discovery installed on his or her own network workstation.



Image Directory
Watermark Discovery does not, under normal circumstances, embed the entire image file into the 
container document. It embeds an Image Object™ that has pointers back to the original file. 

Therefore, network users must be able to locate the file that contains the object. Watermark Discovery 
finds the original object file by looking in the image storage directory that was specified    at the time that 
the image was embedded.

Each user of Watermark Discovery must use exactly the same storage directory. To do this:

1. Create a Watermark Discovery image storage directory on the network server disk.

2. Each Watermark user on the network must specify this directory as the image storage directory 
for his or her own copy of Watermark Discovery.



Storage Medium
If you are using Watermark Discovery on a network with several other Watermark Discovery users, then it
is likely that the number of stored image files will grow rapidly. Even with compression, TIFF files can be 
very large; multi-page TIFF files can easily exceed 1MB in size. Even the largest magnetic disk will soon 
be full when you store these files.

The solution is to use an optical disk attached to the network server. Watermark Discovery does not 
directly support optical disk drives (you will need to upgrade to Watermark Professional Edition for such 
facilities). However, you can use an optical drive that uses a magnetic drive interface (e.g., Corel or 
Netware 4.0 HCSS). Such products treat the optical drive just as if it were another standard magnetic 
hard disk.



Scan Servers
Since fast scanners can be fairly expensive, it is a good idea to share these between several users. The 
best way to accomplish this with Watermark Discovery Edition is to set up a dedicated computer with the 
scanner in a common location such as the photocopier room. This computer should have its own E-Mail 
node setup with a user name of "Scan Server." 

Any user who wants to scan a document would walk up to this machine and do the following:

1. Create an E-Mail message addressed to himself or herself or anyone else to whom they want to 
send the document. 

2. Use Insert Object... to insert a Watermark Discovery Image Object™ in the mail message.

3. Scan and save the image from within Watermark and return to the mail message by closing 
Watermark.

4. Send the mail message.

5. To use the Image Object™ in another software package, the user would return to his or her desk 
and copy and paste the image from the mail message into the other package.

Note: Watermark is planning to produce a dedicated scan server to simplify this task.    This dedicated 
scan server will be available later in 1993.



Fax Servers
If you are using a fax server, Watermark can import the images produced from incoming faxes and mail 
these around the network. Most fax servers or standalone fax products will store faxes in an incoming fax 
directory. Watermark allows you to set up this directory in your user preferences (Edit, Preferences..., 
Application). Once you set up this directory, you can import incoming faxes directly by using the Fax 
button on the Toolbar or File, Open Fax.... Make sure that your fax software stores its faxes in one of the 
file formats that Watermark can import. These formats include TIFF, DCX, and PCX.



Wide Area Networks
A user on one network usually cannot access the server of another network directly.    In such cases, the 
recipient of an E-Mail message that includes an embedded Watermark Discovery Image Object™ cannot 
access the original image document. (The user can double-click on the Image Object™, but the system 
will not be able to locate the document in which the image is stored.)

To solve this problem when using Watermark to send an E-Mail message to a remote site, use the File, 
Embed entire command. This command stores a complete copy of the image document in the container 
document (that is, the E-Mail document). The size of the E-Mail document increases correspondingly.

The transmission time depends upon the speed of your modem. Transmitting a fully embedded Image 
Object™ via a 9600 baud modem should take less time than transmitting the same document by fax, as 
Watermark uses a more efficient compression system.

Remember that if you receive a fully embedded Image Object™ from a remote site, the copy in your E-
Mail document is not directly linked to the source. If the original    document has changed, the copy you 
receive will not include any of those changes.



Security
Watermark Discovery Edition relies on the security of your network to prevent unauthorized access to 
images. The Professional Edition provides a much more sophisticated security mechanism, allowing each
page or annotation to be selectively secured from viewing, modifying, or deleting.

Despite its limitations, it is still possible to set up a fairly sophisticated security system with Watermark 
Discovery Edition. You can accomplish this by setting up sub-directories within the main image directory 
that reflect the different workgroups that may need to share secured documents. Only authorized users 
should be allowed to access the files in these directories. Any image that is designated for that workgroup
should be stored in that workgroup's sub-directory.



Points to Remember
1. You can embed the same Watermark Discovery Image Object™ into different destination 

application files.

2. Since the Watermark Discovery source is linked to the Image Object™, you can only view and not
change the original under Watermark Discovery if a co-worker is already examining it through a 
different Image Object™ embedded in a different application file. You get an error message. But, 
you can still view the image. This feature ensures that everyone examines the same file and not 
different 'versions' of it. 

3. If you expect to do a lot of work with Watermark Discovery, load one extra copy of Watermark first
and then minimize this copy. This way, whenever you need to view an Image Object ™, it takes 
less time to load because the Watermark Discovery program is already in memory.

Opening several instances of Watermark does not use any extra memory because Windows is 
clever enough to use the same program code.



Sending Images to Remote Mail Users
Under normal circumstances the Image Object™ is only a pointer to the original file. This means that the 
recipient of any document that contains an Image Object™ must have access to the original source file.    
For example, the recipient must be on the same local area network.

If this is not the case and you wish to send the document to a remote site, then you can use the File, 
Embed entire command. This command embeds the entire source image file into the destination 
application file. You can then E-Mail the destination file to the remote site or send a disk through the mail. 
In this case,    there is no link back to the original file on your own system.



The File Menu
The standard File Menu commands are New..., Open..., Open Fax..., Close, Save, Save As..., Search..., 
Properties..., Import…, Export…, Printer Setup..., Print, and Exit.    Update application name and Embed 
entire replace the save commands when an Image Object™ is being embedded into another application. 
At this time, Exit changes to Exit & return to application name.

Related Topics:
New...
Open...
Close
Save
Save As...
Search...
Properties...
Import
Export
Printer Setup...
Print
Exit
Update application name
Embed Entire
Exit & return to application name



New...
Menu/Keyboard: File, New...

Function: Creates a new empty TIFF document file.

Operation: Select File, New...

This command creates a new empty TIFF file. If you changed the current image file, you are given the    
option of saving the changes. If you do not save the changes, the work area is cleared.



Open...
Menu/Keyboard: File, Open... or Open button

Function: Opens an existing TIFF document file.

Operation: Select File, Open... or click the Open button on the Toolbar.

This command displays the Windows Open dialog box. Use the List Files of Type box to select the type of
file (by filename extension) that you wish to open. The available options are TIFF files with a .TIF 
extension, or All Files with a *.* filename. All Files will show if there are any backup (.BAK) files in the 
directory. Note that Watermark Discovery only opens TIFF files and TIFF file backups (.BAK).

Use the remaining boxes to specify the drive and directory containing the required file. When you have 
located the file you wish to open, double-click on the filename or press the OK button.



Close
Menu/Keyboard: File, Close or Close button

Function: Closes the current TIFF document file.

Operation: Select File, Close or click the button on the Toolbar.

This command closes the current document and leaves you with a blank work area. If you changed the 
document (e.g., added a comment) since the last Save command, then you will be asked if you wish to 
save the changes before closing. Choose Yes, No, or Cancel as appropriate.

If you save the file for the first time, the Document Properties window appears.



Save
Menu/Keyboard: File, Save

Function: Saves the current TIFF document file.

Operation: Select File, Save.

This command saves the current document with all modifications to the disk and leaves the file open on 
the screen. Save does not close the file.

If you save the file for the first time, the Document Properties window will appear. 

When you use the Save command, the existing file on disk is renamed to filename.bak.



Save As...
Menu/Keyboard: File, Save As

Function: Saves the current TIFF document as another file with a different filename. 

Operation: Select File, Save As.

The Save As dialog box appears. Enter the location (drive and directory) in which you wish to save the 
new file and the new filename. Click the OK button.

When you use the Save As command, the new file is left open on screen. The new file keeps exactly the 
same Document Properties as the original file. 



Search...
Menu/Keyboard: File, Search...

Function: Looks for a TIFF document file that meets your specified search criteria.

Operation: Select File, Search... or click the Search button on the Toolbar.

Search... displays the Search Document Properties dialog box. This box allows you to specify the criteria 
for your search.    Enter the search criteria that have been associated with different files via the Properties 
command.

The search options include basic properties:

Document name

Created by 

Date created

Type

Description

and also user defined fields and keywords.

For further information on the search properties, see Document Properties, Searching, & Deletion 
Assistance. To find a particular file or files with the Search command, place the cursor in the relevant box 
and enter the file property value (search criterion). You can use any combination or number of search 
criteria. You can also enter only the first few characters for any entry followed by an asterisk (*).

When you have entered the search values, click the Search button. Watermark Discovery will search the 
files and display a box containing a listing of all the files meeting the specified criteria. Double-click the 
entry in the search results list or select the file you want and click the Open button. 



Properties...
Menu/Keyboard: File, Properties...

Function: Attaches properties to, or edits the properties of, the current TIFF document file.

Operation: Select File, Properties... or click the button on the Toolbar.

The Document Properties dialog box appears. You can use this dialog box to associate individual 
properties or values with the current file. You may then use the File, Search... command to search through
the properties of all of the stored files in order to locate a particular file image.

For further information on the use of Document Properties, refer to Document Properties, Searching, & 
Deletion Assistance. 

The available properties are: Basic properties, User defined Fields, Deletion Rule, and Keywords.

Basic properties

Document name (this is not the filename, but a name that you enter into the field, and can be up 
to 32 characters long)

Created by (that is, author or authors; and up to 24 characters in length)

Date created (the date that the document was created. This field is filled automatically. You may, 
however, edit this field if you wish to change the date)

Type (this field may contain up to 15 characters, and allows you to create different 'groups' of 
documents; for example, invoices, contracts, purchase orders, etc.)

Description (you may enter your own description of the file in up to 40 characters)

The Basic properties can be used as file search criteria in the File Search command. They are, however, 
by their very nature more descriptive than definitive. The Keywords and User defined Fields allow you to 
associate specific search criteria to the different files.

Keywords

You can associate keywords of up to 24 characters to each file. To do so, place the cursor in the 
keywords entry box and type in the word. Then click the Add button. You can remove the keywords by 
selecting the required word and pressing the Delete button. You may also edit the keywords by selecting 
the required word, editing it in the entry box, and then pressing the Add button when you are happy with 
the changes.

User Defined Fields

The user defined fields area of the Document Properties window allows you to specify up to ten different 
fields (labels) and field values (data) for each document type. For example, if you had a document type of 
"Map," you could assign the label "location" and the data "Veemax."

To use, click the Edit Fields button. This displays the User Defined Fields window. Enter the field names 
or labels that you wish to use for the current file (up to ten, each of which can be up to 16 characters). 
When you finish, click the OK button.

Deletion Rule

Allows you to specify when a document should be deleted. To activate, click the check box . Then select 
an expiration time from the drop down list or type an expiration time (in months) in the box provided in the 
Deletion Rule Area.    

The defined field names will now appear in the User defined Fields part of the Document Properties 
window, allowing you to enter individual field values against the different labels. The values can be up to 
24 characters long.

The user defined fields are stored in the file WATERMRK.FLD. To pass your definitions to another user, 



you can copy individual entries from your file to their file or you can pass them your entire file.



Import
Menu/Keyboard: File, Import...

Function: Imports an image from a file that is in a different format.

Operation: Select File, Import.

This command allows you to import files from different applications. The standard Windows Open window
appears.

The available file options are

Windows Bitmap (*.bmp)

Multi-page DCX (*.dcx)

Single-page PCX (*.pcx)

Compuserve (*.gif)

TARGA (*.tga)

TIFF Files (*.tif)

Encapsulated PostScript (*.eps)

Windows Metafile (*.wmf)

All Files (*.*)



Export
Menu/Keyboard: File, Export...

Function: Exports a file to a different file format.

Operation: Select File, Export...

This command allows you to export a file to a format suitable for different applications. The standard 
Windows Save As window appears.

The available file options are

Windows Bitmap (*.bmp)

Multi-page DCX (*.dcx)

Single-page PCX (*.pcx)

Compuserve (*.gif)

TARGA (*.tga)

TIFF Files (*.tif)

Encapsulated PostScript (*.eps)

Windows Metafile (*.wmf)

All Files (*.*)



Printer Setup...
Menu/Keyboard: File, Printer Setup.

Function: Sets up the print options.

Operation: Select File, Printer Setup.

This command displays the Windows Print Setup dialog box. 

Refer to your Windows User Manual for further information on setting up different printers to work with 
Windows. 



Print
Menu/Keyboard: File, Print or the Print button

Function: Prints the current page or all of the current TIFF document.

Operation: Select File Print or click the Print button on the Toolbar.

This command displays the Print dialog box.

You can print all or a range of pages. You can specify the number of copies, and you can print to a file 
rather than the printer.

A Setup button will bring up the Printer Setup dialog box if you need to change the default printer.



Exit
Menu/Keyboard: File, Exit

Function: Exits Watermark Discovery.

Operation: Select File, Exit.

This command will close Watermark Discovery immediately if there is no open document in the screen 
work area or if you did not change the current document file since the last Save command. If the current 
file has been modified in any way, then you are given the options to save the changes, discard the 
changes, or cancel the Exit command.



Update application name
Menu/Keyboard: File, Update

Function: Updates the Image Object™ of the current file in the named application.

Operation: Select File, Update.

This command is only available during an OLE operation where Watermark Discovery is the object being 
embedded. It allows you to embed or update the Image Object™ of the Watermark Discovery file into the 
other application. 



Embed Entire
Menu/Keyboard: File, Embed Entire

Function: Embeds a complete copy of the file into the other application.

Operation: Select File, Embed Entire.

This command is only available during an OLE operation where Watermark Discovery is the source 
application. It allows you to embed or update a complete copy of the file Image Object™ of the 
Watermark Discovery file, rather than just the pointer back to the original file.

The command should be used where the user of the destination application does not have access to the 
disk directory in which the original Watermark Discovery file is stored. An example would be where an 
Image Object™ is being embedded into an E-Mail message for transmission to a remote site not 
connected to your own network.



Exit & return to application name
Menu/Keyboard: File, Exit

Function: Closes the current copy of Watermark Discovery and returns to the named 
application.

Operation: Select File, Exit.

This command is only available during an OLE operation where Watermark Discovery is the source 
application. It closes the copy of Watermark Discovery that has been opened by the OLE process, and 
returns you to the destination application. If you have made any changes to the Watermark Discovery file,
or if you have not yet 'embedded' the Image Object™ into the other application, you are given the option 
of updating the application before Watermark Discovery closes.



The Edit Menu
The Edit Menu commands are Cut, Copy, Copy Picture, Paste, Clear, Insert Blank Page, Insert Files, 
Comment, and Preferences...

Related Topics:
Cut
Copy
Copy Picture
Paste
Clear
Insert Blank Page
Insert Files
Comment
Preferences...



Cut
Menu/Keyboard: Edit, Cut or the Ctrl key + X      

Function: Cuts a TIFF image of the page to the Clipboard (as a TIFF image).

Operation: Select Edit, Cut or press the Ctrl key and the X key.

The current page is removed from the file and a TIFF image copy is placed in the Clipboard. This can be 
pasted back to the Watermark Discovery file, or into a different Watermark file. 

Note that the image in the Clipboard stays there only until you Cut or Copy another image into the 
Clipboard.



Copy
Menu/Keyboard: Edit, Copy or the Ctrl key + C 

Function: Copies the current TIFF image page to the Clipboard (as a TIFF image).

Operation: Select Edit, Copy; or press the Ctrl key and C; or click the Toolbar button. 

This command will copy the complete current page of the file, as a TIFF image, to the Clipboard, leaving 
the original image intact. You may Edit, Paste the image back into the current file or into another 
Watermark file. Because of the unique structure of Watermark's files, you cannot paste the image into 
different applications. Use Edit, Copy Picture for this.



Copy Picture
Menu/Keyboard: Edit, Copy Picture

Function: Copies the current page, or a selection from the current page (see Tools Select), 
to the Clipboard as a bitmap image.

Operation: Select Edit, Copy Picture.

If you have used the Select command to select a portion of the current image, it is copied to the Clipboard
as a bitmap image. If you have not made a selection, then the entire page is copied to the Clipboard as a 
bitmap image.

The bitmap image may then be pasted into any other Windows application.



Paste
Menu/Keyboard: Edit, Paste or the Ctrl key + V 

Function: Pastes a TIFF image page from the Clipboard.

Operation: Select Edit, Paste; press the Ctrl key and the V; or use the Paste button on the 
Toolbar.

This command will paste a TIFF image page from the Clipboard into the current document. The image in 
the Clipboard must be in the TIFF format ¾ the option is inactive otherwise.

The command does not overwrite the existing image page on the screen, but inserts a new image page 
into the document. Notice that the page indicator at the bottom of the screen alters to accommodate the 
new page.



Clear
Menu/Keyboard: Edit, Clear or the Delete key.

Function: Clears the current TIFF image page.

Operation: Select Edit,    Clear or use the Delete key.

This command clears or deletes the current page from the document. It is similar to the Cut command, 
except that no copy is placed into the Clipboard.

If you Clear a page by mistake, you will only be able to recover it by immediately using the File, Close 
document command (without saving it) and re-opening the original file. Click the NO button when you are 
asked if you wish to save the document.

If this doesn't work, examine the directory for a .BAK backup file.



Insert Blank Page
Menu/Keyboard: Edit, Insert Blank Page

Function: Inserts a new blank page.

Operation: Select Edit, Insert Blank Page.

This command inserts a blank page in front of the current page.

If there is no file open, the command creates an 'untitled' file and inserts the blank page as the first page.



Insert Files
Menu/Keyboard: Edit, Insert Files...

Function: Inserts a TIFF file into the current document.

Operation: Select Edit, Insert Files....

This command displays the Insert Files... dialog box.

Select the Watermark Discovery file you wish to insert into the current document file and click the OK 
button. The selected file is inserted in front of the current page of the current document file and the page 
indicator at the bottom of the screen changes to indicate the new size of the document.

Repeat the process if you wish to insert additional files.



Comment
Menu/Keyboard: Edit, Comment

Function: Allows you to edit a selected annotation.

Operation: Select Edit, Comment.

To use this command you must first select a comment on the image file. The command brings up the sub-
menu for the selected comment (Text, Redliner, OLE object, Sound, Highlighter, Arrow) which you may 
use to edit or delete the comment. A description of the sub-menu for each type of comment is included in 
the discussion of that comment.



Preferences...
Menu/Keyboard: Edit, Preferences

Function: Sets or edits the current user preferences for Watermark Discovery.

Operation: Select Edit, Preferences.

This command has two sub-options: Application and Comment.

Application.    (Edit, Preferences, Application) This option allows you to set Watermark Discovery's user 
options. There are the following sets    of options: Default Paths; Initial display options; and Miscellaneous.
If you change the preferences, the changes take effect when you next start Watermark Discovery.

Default Paths. This option allows you to specify the path used by Watermark Discovery when opening or 
saving files. If you intend to store your document files in a directory file other than the default IMAGES 
directory set up during installation, use this command to specify the location. Provided that the directory 
exists, you can use the Image Path button to specify the new drive and directory. This becomes the 
default directory displayed by Watermark Discovery whenever you use the Open command or button, and
the default location whenever you use the Save command.

Fax Path. This options allows you to tell    Watermark where your fax software stores its incoming fax 
images. Pressing the fax button or using File, Open Fax...will then present you with a dialog box to import 
a file from this directory.

Initial display options. This option allows you to specify the initial view presented by Watermark 
Discovery whenever you open a new file. The options are 

View Normal Size (scales the page so that it shows at the same size as the original paper 
document)

View Whole Page (scales the page so that it is entirely visible within the window)

View Width of Page (fits the image so that it fills the full width of the available window)

View Length of Page (fits the image so that its full height is displayed in the available window)

No Scaling (Shows the available portion of the image without any scaling. As a result, one scaled
pixel will take up one pixel on the screen.)

Percentage (shows the image scaled to the specified size relative to the original)

Three additional start-up options are available:

Scale to Grey (Scales the image to grey. This feature is a powerful display enhancement 
algorithm used by Watermark to optimize the quality of displayed images on low resolution color 
or grey scale displays. Turning off Scale to Grey will result in a faster display, but a much poorer 
quality.)

Thumbnails View (show the file as thumbnail images ¾ this has the added advantage in multi-
page documents of allowing you to go straight to the particular page you wish to view, see View 
Thumbnails.

Set Window Position. This option allows you to set the opening position of the display window. 
The position set is the current position (size and shape) of the window.

Miscellaneous.    The Miscellaneous options allow you to set the Display dpi specification, to change the 
User Name that appears in the File Properties option, to Create (automatic) Backups, to Keep (the TIFF) 
File Tidy, and to Set Properties on Save. There is also a Comments button that provides an alternative 
route to the Edit Preferences Comment dialog box.

Keep File Tidy option automatically compresses spurious space within the TIFF file when the file 
is saved. It makes the save process slightly slower, but makes file opening and manipulation 
faster. It also saves on disk space by keeping the file size as small as possible. It is highly 



recommended that you keep this option turned on. 

Set Properties on Save option will force the Document Properties Window to pop up whenever 
you save a new file for the first time. This is an important feature if you have a standard properties
defined for file retrieval (refer to Document Properties, Searching, & Deletion Assistance.)

Comments.    Edit, Preferences, Comment. This option allows you to specify the appearance of the 
various Watermark Discovery annotations (see the Tools menu. The 'comments' covered are Text, 
Redline, Arrows, and Highlight. The options you set here become the default settings used at start up.

Text Comments. You can change the text format, and the background format.

Text options include Font and Color buttons to change the style and appearance of the text 
comments. The Font button displays the Font dialog box. Here you can specify the font, the font 
style and the point size for Text comments. You can also specify Strikeout and Underline text 
effects, and you can change the text color to any of the 'basic colors'. For further information on 
fonts, refer to your Windows manual. The Color button allows you to define new colors.

Backround options include a Transparent check box and a Color button. 

A Text Sample window shows the effect of the Text specifications you have set.

Redline Comments. You can change the line format in three ways:

Line Style; choose from

Solid
Dash
Dot
DashDot
DashDotDot

Line Size; choose from

Hairline (0.00mm)
Thin (.20mm)
Normal (.50mm)
Thick (1.00mm)

Set Color button;

changes the color of the Redline comments (the current color is displayed in the adjacent box).

Arrow Comments. You can change the arrow format in six ways:

Line Style; choose from

Solid
Dash
Dot
DashDot
DashDotDot

Line Size; choose from

Hairline (0.00mm)
Thin (.20mm)
Normal (.50mm)
Thick (1.00mm)

Arrow Length: choose from

None (0.00mm)
Short (2.00mm)
Normal (5.00mm)
Long (10.00mm)



Arrow Width: choose from

None (0.00mm)
Narrow (1.00mm)
Normal (3.00mm)
Wide (6.00mm)

Set Color button;

changes the color of the Arrow comments (the current color is displayed in the adjacent box).

Fill arrow heads:

check the box to create filled arrow heads.

Highlight.    The Highlight box has a single Set Color button that allows you to set the color for the 
Highlight comments that you add to the document file.

Once you have set the Comment Preferences, click the OK button. Choose the Cancel button if you wish 
to return to your original settings, or the Help button if you want on-line help information.



The View Menu
The View Menu commands are Thumbnails, Normal Size, Whole Page, Width of Page, Length of Page, 
No Scaling, Scale to Grey, Rotate, Hide Comments, Magnifier, Zoom In, Zoom Out, First Page, Previous 
Page, Next Page, and Last Page.

Related Topics:
Thumbnails
Normal Size
Whole Page
Width of Page
Length of Page
No Scaling
Scale to Grey
Rotate
Hide/Show Comments
Magnifier
Zoom In
Zoom Out
First Page
Previous Page
Next Page
Last Page



Thumbnails
Menu/Keyboard: View, Thumbnails

Function: Toggles a thumbnail view of the page or pages on or off.

Operation: Select View, Thumbnails or click the Toolbar button.

This command toggles the display into or out of the Thumbnail Mode. A thumbnail is a small view of the 
image. In Thumbnail Mode, all of the different pages of a multi-page document can be seen 
simultaneously on the screen.

You exit Thumbnail Mode by repeating the command, or by double-clicking on one of the page images.

Thumbnail Mode has two advantages. It allows you to see an overview of the entire document. It allows 
you to move rapidly to a different page without having to scroll through the whole document to find the 
particular page you want. To do this, move the cursor to the relevant page image and double-click. The 
display returns to a full-size view of that page.

You can also copy a page from one TIFF file to another by dragging a thumbnail from one Watermark 
Discovery window to another Watermark Discovery window. Watermark Discovery needs to be loaded 
twice, and each window must be in Thumbnails view.



Normal Size
Menu/Keyboard: View, Normal Size

Function: Scales the page to match the display resolution.

Operation: Select View, Normal Size.

This command will scale the image to match the display resolution selected in the Edit Preferences 
Application command.



Whole Page
Menu/Keyboard: View, Whole Page

Function: Scales the whole page to fit in the window.

Operation: Select View, Whole Page.

This command will scale the image so that it is entirely visible at its best possible fit within whatever size 
or shape window is currently being used.



Width of Page
Menu/Keyboard: View, Width of Page

Function: Fits the image to the full width of the window.

Operation: Select View, Width of Page or click the Toolbar button.

This command will scale the image to the full width of the Watermark Discovery window. On most 
standard PC screens, you will therefore lose the bottom portion of a portrait image off the bottom off the 
screen. Use the vertical elevator slide on the right of the screen to scroll up and down.



Length of Page
Menu/Keyboard: View, Length of Page

Function: Fits the image to the full height of the window.

Operation: Select View, Length of Page or click the Toolbar button.
This command will scale the page image so that it fits the full height of the Watermark Discovery window. 
This enables you to see the whole image on whatever size window or screen you are using. 



No Scaling
Menu/Keyboard: View, No Scaling

Function: Switches off image scaling.

Operation: Select View,    No Scaling.

This command will display the image without any scaling being used. As a result one scanned pixel will 
take up one pixel on the screen.



Scale to Grey
Menu/Keyboard: View, Scale to Grey

Function: Scales the image to grey.

Operation: Select View, Scale to Grey.

This feature is a powerful display enhancement algorithm    used by Watermark to optimize the quality of 
displayed images on low resolution color or grey scale images.



Rotate
Menu/Keyboard: View, Rotate 

Function: Rotates the image.

Operation: Select View, Rotate or click the button.

The menu command provides three options; which are rotate the image

Clockwise 90 degrees

Flip 180 degrees

Counter-clockwise 90 degrees

The Rotate button on the Toolbar will always rotate the image by 90° increments in a clockwise direction.



Hide/Show Comments
Menu/Keyboard: View, Hide Comments or View, Show Comments

Function: Hides or shows any comments on the file image.

Operation: Select View, Hide Comments or View, Show Comments.

This is a toggle command. When comments are visible on the file image, the View menu shows the Hide 
Comments option. If you select this command, the comments become invisible although they are still 
attached to the file image.

If comments exist but have been hidden, the menu displays the Show Comments option. If you select this
command, all hidden comments become visible. Note that while the comments have been hidden, the 
annotation buttons on the Toolbar are dimmed and unavailable. This is a good quick indication of 
whether any comments are invisible on an apparently blank image file.



Magnifier
Menu/Keyboard: View, Magnifier

Function: Puts a magnification window on the screen.

Operation: Type View, Magnifier or click the button on the Toolbar.

This command puts a Magnifier window onto the screen. The magnification window can be moved and 
sized like any other Windows window. It contains an enlarged view of part of the file image.

Move and size the window so that it fills the right portion of the screen that is currently blank. A magnified 
view of the image appears in the Magnifier window. The enlarged view reflects the original position of the 
Magnifier glass over the image. When the cursor is over the image and outside the Magnifier window, it 
changes to a magnifying glass.

To see an enlarged view of a different part of the document, place the cursor outside of the Magnifier 
window in the part of the image that you want to magnify and click the left mouse button. A box, which is a
scaled down image the size and shape of the Magnifier window, appears. A magnified view of the boxed 
area that you select displays in the Magnifier window. To magnify another area of the image, move the 
cursor to that area and click. To zoom in or zoom out of the image in the Magnifier window ny fixed 
degrees, use the Zoom In and Zoom Out buttons located in the top left corner of the screen.



Zoom In
Menu/Keyboard: View, Zoom In

Function: Zooms in on the image.

Operation: Select View, Zoom In or click the button on the Secondary Toolbar.

This command zooms in to, i.e., increases the size of, the image on the screen. It may be used 
repeatedly to increase the image to the desired size.



Zoom Out
Menu/Keyboard: View, Zoom Out

Function: Zooms out from the image.

Operation: Select View, Zoom Out or click the button on the Secondary Toolbar.

This command zooms out from, i.e., decreases the size of, the image on the screen. It may be used 
repeatedly to reduce the image to the desired size.



First Page
Menu/Keyboard: View, First Page

Function: Displays the first page of a multi-page document.

Operation: Select View, First Page or click the button on the Secondary Toolbar.

This command will display the first page of a multi-page document. If you are already on the first page, or 
if it is a single-page document file, then the menu option is dimmed and is not available.



Previous Page
Menu/Keyboard: View, Previous Page

Function: Displays the previous page of a multi-page document.

Operation: Select View, Previous Page or click the button on the Secondary Toolbar.

This command will display the previous page of a multi-page document. If you are already on the first 
page, or if it is a single-page document file, then the menu option is dimmed and is not available.



Next Page
Menu/Keyboard: View, Next Page

Function: Displays the next page of a multi-page document.

Operation: Select View, Next Page or click the button on the Secondary Toolbar.

This command will display the next page of a multi-page document. If you are already on the last page, or
if it is a single-page document file, then the menu option is dimmed and is not available.



Last Page
Menu/Keyboard: View, Last Page

Function: Displays the last page of a multi-page document.

Operation: Select View, Last Page or click the button on the Secondary Toolbar.

This command will display the last page of a multi-page document. If you are already on the last page, or 
if it is a single-page document file, then the menu option is dimmed and is not available.



The Tools Menu
The Tools menu includes two sub-sections of commands: image manipulation tools, and a series of 
annotation tools.

The manipulation tools are Pan, Zoom and Select.

The annotation tools are Text, Redliner, OLE object, Sound, Highlighter, Arrow and Eraser.

It is useful to consider the Tools commands as toggle switches, and the various effects as 'modes'. In this 
way it is easy to understand how you toggle from Standard Mode (standard mouse pointer cursor) into 
and out of the various Tools Modes.

Note that the Text, Redliner, OLE object, Sound, Highlighter, and Arrow Modes also have their own sub-
menus that can be displayed by pressing the right-hand mouse button.

Related Topics:
Pan
Zoom
Select
Text
Redliner
OLE Object
Sound
Highlighter
Arrow
Eraser



Pan
Menu/Keyboard: Hold the Shift key and drag the cursor. Or, Tools, Pan.

Function: Moves the image in any direction when you hold down the left mouse button and 
drag the cursor.

Operation: Press the Shift key and drag the cursor. Or, select Tools, Pan.

We recommend that you use the press-and-drag method when you pan. The menu version is also 
available, but it is much slower and less convenient to use. 

This command toggles the Pan Tool on and off. When in Pan, a four-arrow cursor like a compass showing
N, S, E and W appears on the screen. It is used when the image has been enlarged so that not all is 
visible within the window. You can then use Pan to move the document around so that different parts of 
the image can be seen within the window.

Repeat the command when you wish to leave Pan. 

If you hold down the Shift key on the keyboard, you will enter Pan from whatever mode is current. You will
stay in Pan for as long as you hold down the Shift key. When you release the key you will return to the 
original mode.



Zoom
Menu/Keyboard: Hold the Ctrl key and drag the cursor. Or, Tools, Zoom.

Function: Places a magnifier-plus cursor on the screen and allows you to zoom in on a 
specified area.

Operation: Press the Ctrl key and drag the cursor. Or, Tools, Zoom.

We recommend that you use the press-and-drag method when you zoom. The menu version is also 
available, but it is much slower and less convenient to use. 

This command should not be confused with the magnifier buttons found on the Secondary Toolbar at the 
bottom of the screen, or the Magnifier button on the Toolbar. This command allows you to zoom in on a 
specified part of the document.

The Tools, Zoom command toggles into and out of Zoom Mode. In Zoom Mode a magnifier containing a 
plus cursor is placed on the screen. Move the cursor to the top left of the portion of the document that you
wish to see in greater detail. Hold down the left-hand mouse button and drag the cursor down and to the 
right. This highlights a block shown in reverse video on the screen. When you have selected the required 
area, release the mouse button. The selected area is then displayed on the screen at the maximum size 
possible within the window.

Repeat the command to toggle between Zoom and the Standard cursor.

If you hold down the Ctrl key on the keyboard, you will enter Zoom Mode from whatever mode is current. 
You will stay in Zoom Mode for as long as you hold down the Ctrl key. When you release the key you will 
return to the original mode.



Select
Menu/Keyboard: Tools, Select

Function: Allows you to specify and select a rectangular area of the image.

Operation: Select Tools, Select.

Select Mode places a '+' cursor onto the screen. Use this to select a rectangular area to Edit Copy Picture
to the Clipboard as a bitmap image. This is the only way that you can copy and paste (without using OLE)
from Watermark Discovery to another application.

To select the area you wish to copy, move the cursor to the top left-hand corner of the required area. Hold
down the right-hand mouse button and drag the cursor down and to the right. The selected area is shown 
in reverse video.



Text
Menu/Keyboard: Tools,    Text or Text button on the Toolbar

Function: Allows you to type comments from the keyboard.

Operation: Select Tools, Text or click the button on the Toolbar.

This command allows you to add a Text comment to the document image. The default appearance of the 
comment is that specified in the Edit Preferences Comment dialog box.

When you select this command, an ABC cursor appears on the screen. Move this cursor to the position at
which you wish to add the comment. Click the left-hand mouse button. A flashing vertical line cursor 
appears on the screen. Type the required comment. When you have entered the text, de-select the Text 
Mode by repeating the command or entering another mode.

You can edit the comment by moving the cursor over the text and clicking the left-hand mouse button. An 
'I' cursor will appear. Click the left-hand mouse button at the point at which you wish to start editing. You 
may then use the standard keyboard editing keys to change the text or add new text.

You can reposition the comment by positioning the cursor over the Text comment and holding down the 
left-hand mouse button. An outline will appear around the text. Drag this outline to the new position and 
release the mouse button. 

While in Text Mode, a Text sub-menu can be displayed by pressing the right mouse button. 

Use this sub-menu when you wish to change the format of the text comment that you are currently typing,
or for an existing Text comment. In the latter case, select a text comment while in Standard Mode and 
then clicking the right-hand mouse button. 

Whenever one of the options is dimmed on the sub-menu, it means that it is currently unavailable. The 
options are: 

Cut. This option will remove the current text comment and place in on the clipboard.

Copy. This option will place a copy of the current text comment on the clipboard, leaving the 
original comment unchanged.

Clear. This option will remove the selected Text comment but will not change the clipboard.

Text Properties...

You can change the text format and the background format.

Text options include Font and Color buttons to change the style and appearance of the text 
comments. The Font button displays the Font dialog box. Here you can specify the font, the font 
style and the point size for Text comments. You can also specify Strikeout and Underline text 
effects, and you can change the text color to any of the 'basic colors'. For further information on 
fonts, refer to your Windows manual. The Color button allows you to define new colors.

Backround options include a Transparent check box and a Color button. 

A Text Sample window shows the effect of the Text specifications you have set.

To exit the Text sub-menu without selecting any of the options, click the mouse button anywhere outside 
of the sub-menu.



KK Redliner;ToolbarRedliner
Menu/Keyboard: Tools, Redliner or the Redliner button on the Toolbar

Function: Allows you to add freehand (written) comments via the mouse.

Operation: Select Tools, Redliner or click the button on the Toolbar.

This command toggles in and out of Redliner Mode. It displays a pencil cursor on the screen. It allows you
to add freehand comments or sketches as comments to the original document image. Use the mouse to 
move the Pencil cursor to the required position. Hold down the left-hand button and use the mouse to 
make your freehand comments. Repeat the command to return to Standard Mode.

You cannot 'edit' a Redline comment. You may, however, use the eraser tool (Tools Eraser) to 'rub out' 
parts of the comment just as you would use an eraser to rub out a pencil written comment on a hard copy 
page.

While in Redliner Mode, a Redliner sub-menu can be displayed by pressing the right-hand mouse button. 
Use this method when you wish to edit the freehand comment that you are currently entering.

The Redliner sub-menu can also be displayed by selecting a Redliner comment and clicking the right 
mouse button. Use this method when you wish to edit a freehand comment that has already been 
entered. 

Whenever one of the options is dimmed on the sub-menu, it means that it is currently unavailable.

Clear. This option will remove the selected Redliner comment from the page.

Redline Properties... You can change the line format in three ways:

Line Style; choose from

Solid
Dash
Dot
DashDot
DashDotDot

Line Size; choose from

Hairline (0.00mm)
Thin (.20mm)
Normal (.50mm)
Thick (1.00mm)

Set Color button;

changes the color of the Redline comments (the current color is displayed in the adjacent box).

If you wish to exit the Redliner sub-menu without selecting any of the options, simply click the mouse 
button anywhere outside of the Redliner sub-menu.



OLE Object
Menu/Keyboard: Tools, OLE Object or the OLE button on the Toolbar

Function: Allows you to embed objects from other applications that support OLE, as an 
annotation.

Operation: Select Tools, OLE object or click the button on the Toolbar.

The Olé cursor appears. Move this to the position you wish to embed your Olé comment and click the left-
hand mouse button. From the Insert New Object selection box, choose the Object Type you wish to 
embed and click OK.

The relevant application is found and loaded. Enter, open or insert the data you wish to embed as 
appropriate. Close the application making sure that you 'update' the Watermark Discovery image file in 
the process.

The embedded object will appear on the Watermark Discovery image file at the point of the Olé cursor.

You may edit the OLE object at any time by double-clicking on the object. This locates the originating 
application and allows you to edit the object.

Alternatively, you may open the OLE object sub-menu by selecting the object in Standard mode and 
clicking the right mouse button.

Following are the options on the sub-menu. Any option on the sub-menu that is dimmed is unavailable.

Cut. This option will remove the current object comment and place it on the clipboard.

Copy. This option will place a copy of the current object comment on the clipboard, leaving the 
original comment unchanged.

Paste. This option will paste the contents of the clipboard onto the current document. It does not 
allow you to have two copies of the same object on one file image, but it does allow you to copy 
the object onto a different page or file. 

Clear This option will remove the selected object but will not place a copy on the clipboard.

Transparent
This option will display the object    as transparent rather than opaque.

Object This option is equivalent to double- clicking on the object itself. It loads the originating 
application and allows you to edit the object.



Sound
Menu/Keyboard: Tools, Sound or the Sound button

Function: Allows you to embed sound recordings.

Operation: Select Tools, Sound or click the button on the Toolbar.

The microphone cursor appears. Move this to the position you wish to embed your Sound comment and 
click the left mouse button. Windows Sound Recorder is loaded.

Enter, open or insert the Sound you want to embed.    Close the application making sure that you 'update' 
the Watermark Discovery image file in the process.

The embedded Sound object will appear on the Watermark Discovery image file at the point of the 
microphone cursor and will appear as a microphone icon.

You may 'play' the Sound object at any time by double-clicking on the object. 

Or, you may open the Sound object sub-menu by selecting the object and clicking the right mouse button.
This brings up the Sound sub-menu.

Any option on the sub-menu that is dimmed is unavailable.

Cut. This option will remove the current object comment and place a copy on the clipboard.

Copy. This option will place a copy of the current object comment on the clipboard, leaving the 
original comment unchanged.

Paste. This option will paste the contents of the clipboard onto the current document. It does not 
allow you to have two copies of the same object on one file image, but it does allow you to copy 
the object onto a different file. 

Clear. This option will remove the selected object but will not place a copy into the clipboard.

Sound Object.
This option has two sub-options:

Play.    This is equivalent to double clicking on the object itself; it 'plays' the Sound object.

Edit.    This option loads Windows Sound Recorder and allows you to edit the Sound object.

Note that you can use the Sound Tool if your computer system has sound hardware installed that is 
compatible with the Windows Sound Recorder.



Highlighter
Menu/Keyboard: Tools, Highlighter or the Highlighter button on the Toolbar 
Function: Highlights rectangular areas, or blocks, of the image via the mouse.

Operation: Type Tools, Highlighter or click the button on the Toolbar.

This command places a highlighter cursor on the screen that can be used to highlight specific rectangular 
areas of the image or blocks of text. Use this in the same way that you would use a highlighter pen on 
hard copy documents. Move the cursor to the required point on the image. Hold down the left mouse 
button and move the mouse downwards and to the right. A colored block will appear over the area 
covered. Release the mouse button when the required area has been covered. This can be used to 
highlight specific parts of the document.

While in Highlight Mode, a Highlight sub-menu can be displayed by pressing the right-hand mouse button.
Use this method when you wish to edit the highlight comment/s that you are currently entering.

The Highlight sub-menu can also be displayed by selecting a highlight comment and then clicking the 
right mouse button. Use this method when you wish to edit a highlight comment that has already been 
entered. This method will select all of the highlight comments, wherever they appear on the page, that 
were entered during a single session of Highlight Mode. 

Whenever one of the options is dimmed on the sub-menu, it means that it is currently unavailable.

Clear. This option will remove the selected Highlight comment from the page.

Properties...

This option allows you to alter the appearance of the Highlight comment by changing its color. 

If different users each use a different color, then you can see at a glance who has made which comments.

If you wish to exit the Highlight sub-menu without selecting any of the options, simply click the mouse 
button anywhere outside of the Highlight sub-menu.



Arrow
Menu/Keyboard: Tools, Arrow or the Arrow button.

Function: Allows you to draw a straight line arrow on the image with the mouse.

Operation: Select Tools, Arrow or click the Arrow button on the Toolbar.

This command allows you to draw a straight line arrow on the document image. You can use it to direct a 
Text or Redliner comment to a precise point on the document. When in Arrow Mode, an arrow cursor 
appears on the screen. To draw an arrow, move the point of the arrow cursor to where you want the 
arrow's shaft to begin. Press and drag the cursor to where you want the arrow to end and release the 
mouse button. An arrow line will appear with the arrow head at the point at which you released the mouse
button.

While in Arrow Mode, an Arrow sub-menu can be displayed by pressing the right-hand mouse button. Use
this method when you wish to edit the Arrow comment that you are currently entering.

The Arrow sub-menu can also be displayed by selecting an arrow comment and clicking the right mouse 
button. Use this method when you wish to edit an arrow comment that has already been entered. 

Whenever one of the options is dimmed on the sub-menu, it means that it is currently unavailable.

Arrow Properties...

You can change the arrow format in six ways:

Line Style; choose from

Solid
Dash
Dot
DashDot
DashDotDot

Line Size; choose from

Hairline (0.00mm)
Thin (.20mm)
Normal (.50mm)
Thick (1.00mm)

Arrow Length: choose from

None (0.00mm)
Short (2.00mm)
Normal (5.00mm)
Long (10.00mm)

Arrow Width: choose from

None (0.00mm)
Narrow (1.00mm)
Normal (3.00mm)
Wide (6.00mm)

Set Color button;

changes the color of the Arrow comments (the current color is displayed in the adjacent box).

Fill arrow heads;

check the box to create filled arrow heads.

Clear



This option will remove the selected Arrow comment from the page.

If you wish to exit the Arrow sub-menu without selecting any of the options, simply click the 
mouse button anywhere outside of the Arrow sub-menu.



Eraser
Menu/Keyboard: Tools, Eraser or the Eraser button on the Toolbar.

Function: Erases comments from the image.

Operation: Select Tools, Eraser or click the button on the Toolbar.

This command toggles the Eraser Mode on or off. When in Eraser Mode an Eraser cursor appears on the 
screen (similar to the Pencil cursor, but with the eraser pointing downwards). You can use this Mode to 
remove comments from the document.

To remove a comment, move the Eraser cursor to the comment concerned. Place the eraser end of the 
cursor over the comment and click the left mouse button. On all comments other than Redliner (freehand)
comments, the comment is reversed while you hold the button down, and removed when you release the 
button.

To erase Redliner comments you must hold the left-hand mouse button down and move it over the 
freehand image, just as you would use an eraser to remove pencil comments from a hard copy document.
(The easiest way to remove a complete Redliner comment is to use the Clear option from the Redliner 
sub-menu, see above.)



The Scan Menu
The Scan Menu commands are Select Scanner..., Scan Setup..., and Scan.

Related Topics:
Select Scanner...
Scan Setup...
Scan



Select Scanner...
Menu/Keyboard: Scan, Select Scanner...

Function: Selects which of the available scanners is to be used.

Operation: Select Scan, Select Scanner...

This command brings up the Select Scanner selection window. Choose the scanner type you are going to
use and click the Select button. For more information on scanning, refer to Scanning.



Scan Setup...
Menu/Keyboard: Scan, Scan Setup...

Function: Sets up the scan options.

Operation: Select Scan Setup.

This command allows you to set the scanner options for the document(s) you are going to scan. For more
information, refer to Scanning. 



Scan
Menu/Keyboard: Scan, Scan or the Scan button on the Toolbar

Function: Starts the scan of a new page or pages, or document.

Operation: Select Scan, Scan or click the button on the Toolbar.

This command performs the scan process in accordance with the Select and Setup options already set. 
For more information, refer to Scanning.



Glossary of Terms
Image Objects™
Toolbar
OLE
TIFF
TWAIN drivers
ISIS drivers
OLE object
OLE container
Object Linking and Embedding (OLE)
Image Object



Image Objects™
The raster (bitmapped) image of a Watermark image file that is embedded in another application file and 
linked back to the original Watermark file.



Toolbar
An area on the Watermark screen, which contains buttons that provide access to the functions that are 
used regularly. It is located below the main menu.



OLE
OLE, Object Linking and Embedding, is a feature of Windows 3.1+, which allows you to include the output
of one application in the output of another application.



TIFF
Tagged Image File Format (TIFF) is the native image format of Watermark.



TWAIN drivers
An industry standard scanner driver specification.



ISIS drivers
Scanner drivers produced by Pixel Translations. 



OLE object
Any application that creates objects that may be inserted into other applications.



OLE container
Any application that allows objects from other applications to be embedded.



Object Linking and Embedding (OLE)
A feature of Windows 3.1+, which allows you to include the output of one application in the output of 
another application. It works only with applications that are OLE capable.



Image Object
The raster (bitmapped) image of a Watermark image file that is embedded in another application file and 
linked back to the original Watermark file.




